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LevenhukLite Rövidített telepítési és alkalmazási útmutató

A LevenhukLite szoftverrel a Levenhuk kamera segítségével készített képeket és videofelvételeket nézheti meg, mentheti 
el vagy szerkesztheti meg. A leírt funkciók és műveletek Windows-kompatibilis alkalmazások esetében érvényesek. A Mac-re 
vagy Linuxra vonatkozó verziók esetében az elérhető funkciók ettől eltérők lehetnek. A Levenhuk vállalat fenntartja a 
jogot, hogy bármely termékét előzetes értesítés nélkül módosítsa vagy kivonja a forgalomból.

LevenhukLite

1. A LevenhukLite futtatásához kattintson duplán a számítógépe asztalán található „     ” parancsikonra 

VAGY

Nyissa meg a képernyő bal alsó sarkában található Start menüt. Lépjen az Applications (Alkalmazások) -> „Levenhuk” 
menüpontra, majd az alkalmazás futtatásához kattintson a LevenhukLite parancsikonra.

Ha módosítani szeretné az alkalmazás nyelvét, akkor a Preferences (Beállítások), menü eléréséhez nyomja meg a Shift-P 
billentyűkombinációt, majd válassza ki a Misc (Egyéb) fület, és a Languages (Nyelvek) opcióban állítsa be a kívánt 
nyelvet. Ennek a műveletnek a végrehajtásához újra kell indítani a számítógépet.

2. Amennyiben a kamera illesztőprogramjait megfelelően telepítették, akkor a kamera neve megjelenik a kamerák 
listájában.

3. Ha a kamera nem jelenik meg a listában, akkor ellenőrizze, hogy az megfelelően csatlakozik-e az USB-kábelen 
keresztül és/vagy a kamera illesztőprogramjait megfelelően telepítették-e.

Amennyiben újra kell telepítenie az illesztőprogramokat, futtassa le a telepítéshez adott CD beállítási varázslóját, majd 
válassza a IInstall Camera Driver (Kamera illesztőprogramjának telepítése) lehetőséget.

Az alkalmazás futtatása

LevenhukLite
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A LevenhukLite fő képernyőjének interfésze

Eszköztár fülei:

Név Leírás

Camera (Kamera) Kameraopciók és a szerkesztéshez használt eszközök.

Folders (Mappák) Fájlkezelő. Lehetővé teszi a kívánt kép vagy videó gyors megkeresését és megnyitását.

Undo/Redo (Művelet 
visszavonása/Művelet 
visszavonásának törlése)

A munkameneten keresztüli műveletek listája. Lehetővé teszi, hogy böngésszen az egyes 
műveletek között és visszavonja azt, vagy törölje a művelet visszavonását.

Measurements (Mérések) A megnyitott fájl paramétereit tekintheti és mérheti meg.

Layer (Réteg) A kép aktív rétegeinek listája.

Interfész elemek:

Menüsor
Tartalmazza az alkalmazás összes műveleti parancsát.

Eszköztár panel
A gyors beállításhoz és az egyes eszközök szerkesztéséhez nyújt hozzáférést.

Munkatér
A szerkesztésre kész megnyitott képeket tartalmazza.

Eszköztár fülei
A megtekintéshez és a szerkesztéshez választhat a különböző eszközök közül.

Eszközsor
A leggyakrabban használt műveletek gombjait tartalmazza.

LevenhukLite



Megteki

A létrejött képet az Exposure & Gain, White Balance, Color Adjustment 
(Expozíció és erősítés, a Fehéregyensúly, a Színbeállítás) vagy más 
eszközökkel is szerkesztheti az eszköztár Camera (Kamera) fülén.

A kamera nevére kattintással számítógépe monitorán élőben követheti a kamerát. 
A Video (Videó) fül jelenik meg a munkatérben.

Kép rögzítése
Kattintson a Frame (Keret) gombra. Az aktuális nézetet rögzíti a 
rendszer és az elkészült kép új munkatér fülön jelenik meg. Ahányszor 
a Frame (Keret) gombra kattint, a rendszer annyiszor rögzít új képet, 
amelyet mindig egy újabb fülön jelenít meg.

Videó rögzítése
Kattintson a Video (Videó) gombra. Válassza ki a fájlformátumot, a 
videó nevét, majd a kimeneti mappát. A fentiek jóváhagyásával a 
kamera élő felvételét videóként menti el a rendszer, amíg Ön a 
felvételt le nem állítja.

Felvételi kameranézetek

A kép szerkesztése

Mentés
A File (Fájl) menüben a kívánt opció kiválasztásával Ön egy vagy akár 
több képet is elmenthet a merevlemezre. Válasszon a Save, Save as 
(Mentés, Mentés másként) vagy a Batch Save (Csoportos mentés) 
opciók közül.

A rendszer az alábbi fájlformátumokat támogatja:

Windows Bitmap (*.bmp,*.dib,*.rle)
JPEG (*.jpg,*.jpeg,*.jpe,*.jif,*.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite File Type (*.tft)

Mérések
A LevenhukLite alkalmazás esetében a képekhez a mérési opciók 
széles kínálatából választhat. Az eszköztár (amelyet a menüsor 
Measurements (Mérések) részéből is elérhet) Measurements 
(Mérések) fülének egyik eszközével a kép különleges paramétereit is 
megmérheti. A képen elhelyezett formák egy másik rétegen 
találhatók, a mentett képet nem módosítják. A lentiekben találja a 
Measurements (Mérések) menüpont eszközeinek teljes listáját.



Eszköz Leírás

Angle (Szög) Két vonal által bezárt szöget mér.

Point (Pont) Elhelyez egy Label Pn (Címke Pt) pontot, majd megadja az x- és az y-koordinátát.

Ellipse (Ellipszis)

Line > Arbitrary Line 
(Vonal > Tetszőleges vonal)

Egy adott rétegen rajzol vonalat két pont között.

Line > Horizontal Line 
(Vonal > Vízszintes vonal)

Egy adott rétegen rajzol vízszintes vonalat két pont között.

Line > Vertical Line 
(Vonal > Függőleges vonal)

Egy adott rétegen rajzol függőleges vonalat két pont között.

Parallel (Párhuzamos) Két egymással párhuzamos vonalat rajzol és megszámozza őket.

Vertical > Four points 
(Függőleges > Négy pont)

Két függőleges vonalat rajzol és megszámozza őket.

Vertical > Three points 
(Függőleges > Három pont)

Két egymásra merőleges vonalat rajzol.

Rectangle (Téglalap) Átló mentén két pontból téglalapot rajzol és megjeleníti annak méreteit.

RoundRect (LekerekítettTéglalap) Lekerekített téglalapot rajzol és annak magasságát és szélességét jeleníti meg.

Ellipszist rajzol.

Circle > Center+Radius 
(Kör > Középpont+Sugár)

Egy adott rétegen kört rajzol a Center+Radius (Középpont+Sugár) módszer 
segítségével.

Circle > Two Points (Kör > Két pont) Egy adott rétegen kört rajzol a Two Points (Két pont) módszer segítségével.
 

Circle > Three Points 
(Kör > Három pont)

Egy adott rétegen kört rajzol a Three Points (Három pont) módszer segítségével.
 

Annulus (Gyűrű) Gyűrűt rajzol (két kört, amelyeknek ugyanaz a középpontja) és megjeleníti a belső 
és a külső sugár méretét.

Two Circlec > Center+Radius 
(Két kör > Középpont+Sugár)

Két kört rajzol (a Center+Radius (Középpont+Sugár) módszerrel) és egy vonallal 
összeköti a két kör középpontját. A pontok közötti távolságot mutatja meg.

Two Circles > Three Points 
(Két kör > Három pont)

Két kört rajzol (a Three Points (Három pont) módszerrel) és egy vonallal összeköti 
a két kör középpontját. A pontok közötti távolságot mutatja meg.

Arc (Ív) Ívet húz három pont között és megjeleníti annak hosszát.

Text (Szöveg) Szövegdobozt helyez el a képen. A jobb egérgomb kattintásával hagyhatja jóvá a 
bevitt szöveget.

Polygon (Sokszög) Helyezzen el annyi pontot az egérrel, amennyit csak szeretne. Sokszög 
létrehozásához kattintson a jobb egérgombbal.



Kérjük, vegye figyelembe, hogy a rendszer méretekhez használt alapértelmezett mértékegysége a pixel. Másik 
mértékegység (mm, nm stb.) választásához Önnek meg kell adnia az aktuális kép felbontását. A méretek további 
pontosításához a vonalzóként működő eszközt is igénybe veheti. A felbontást az Image > Resolution… (Kép > Felbontás...) 
menüpontban adhatja meg (pl. 100 000 pixel/m).

A kép egyes formáinak méreteit a View > Measurement Sheet (Nézet > Mérettáblázat) menüpontban találhatja meg.

Módosítások
Válassza az Image > Adjust… (Kép > Módosítás…) menüpontot.
A lentiekben találja meg a kép módosításához alkalmazható műveletek listáját.

Eszköz Leírás

Lehetővé teszi a kép hisztogramjának módosítását. Azonban a három változó 
(kiemelkedő, árnyékos és közepes tónusú területek) módosítása helyett a görbén 
megtalálható bármelyik pontot szerkesztheti a 0–255-ös tartományban anélkül, 
hogy ez a módosítást hatással lenne a többi pontra.

Curve… (Görbe...)

A rendszer automatikus módon dönti el a kiemelt és az árnyékos területek optimális 
értékeit. Kiválasztja a legvilágosabb és a legsötétebb pontokat, ezeket veszi 
fehérnek és feketének, majd ennek megfelelően módosítja a hisztogramot.

Auto Level (Automatikus szint)
 

Automatikusan módosítja a kép kontrasztértékeit. Különösen akkor működik 
hatékonyan, ha az egész képnek egységes a színárnyalata.

Auto Contrast (Automatikus 
kontraszt)

A hisztogram az eredeti kép RGB-értékeit mutatja és újból kiosztja az értékeket, 
kiegyenlítve őket a végső képen.

Histogram Equalization (Hisztogram 
kiegyenlítése)

Lehetővé teszi a teljes kép fényerejének és kontrasztjának gyors módosítását.Brightness/Contrast… 
(Fényerő/Kontraszt...)

Módosítja a teljes kép színértékeit.Color… (Szín...)

Lehetővé teszi az HL (F) fényes (H – highlights), a M (K) közepesen megvilágított 
(M – midtones) és az S (Á) árnyékos (S – shadow) területek értékeinek módosítását 
a –100...100-as tartományon belül. Ezeket az értékeket kizárólag 24 bites True 
Color típusú képek esetében módosíthatja.

HMS... (FKÁ...)

Lehetővé teszi a képen a közepesen megvilágított területek értékeinek 
módosítását. Minél nagyobb a Gamma (Gamma) értéke,annál sötétebb lesz a kép.

Gamma… (Gamma...)

Lehetővé teszi az egyik szín kiszűrését a bitmap képből. A Red, Green (Vörös, 
Zöld) vagy Blue (Kék) kiválasztásával a rendszer kiszűri a megfelelő információt és 
ennek megfelelően változik meg a végső kép (pl. a Vörös érték kiszűrésével 
kizárólag a Zöld és Kék értékek jelennek meg stb.).

Filter Color… (Színszűrő...)

Lehetővé teszi az egyik szín kivonását a bitmap képből.Extract Color… (Színkivonás...)

Megcseréli a kép színeit, miközben korlátozza az arányokat.Invert (Invertálás)



Feldolgozás
A Process (Feldolgozás) menü számos képfeldolgozási eszközt tartalmaz. A LevenhukLite eszközei ugyanolyanok, mint 
bármelyik grafikus képszerkesztő szoftver eszközei. A lentiekben a menüben található műveletek teljes listáját 
olvashatja

Eszköz Leírás

Megnyitja az Stitch (Egyesítés) párbeszédablakot, amelyben több képből hozhat létre 
egyet.

Stitch (Egyesétés)

Megnyitja a Filter (Szűrő) párbeszédablakot, amelyben a LevenhukLite számos filtere közül 
bármelyiket alkalmazhatja a képen. Mielőtt a szűrőket kipróbálná, tudjon meg többet a 
különböző fórumokon a konvolúciós és a morfológiai szűrőről. Egyéni szűrőt is létrehozhat, 
amelyet a Filter (Szűrő) fülön keresztül érhet el.

Filter... (Szűrő...)

Lehetővé teszi a képintenzitás szintjének beállítását, vagyis a kép kontrasztjának növelését 
és az érzékenység megjelenítését gyenge megvilágítási körülmények között is.

 Range… (Tartomány...)

  

 

 

Lehetővé teszi, hogy több szegmensre (szuperpixelekre) oszthassa a képet a hasonló színű, 
intenzitású vagy textúrájú pixelek szerint. Ezt követően Ön törölheti a szuperpixeleket a 
képről vagy eltávolíthatja a kép többi részét. Ez nagyon hatékony abban az esetben, ha a 
főbb részletek megtartása mellett ki akarja szűrni a zajt a képből.

Segmentation... 
(Szegmentálás...)

Lehetővé teszi a bitmap kép egyszerűsítését. Ha a megadott pixelek szürke szintje 
meghalad egy bizonyos értékhatárt, akkor fehérré változik. Ha nem akkor feketévé változik.

Binary… (Bináris...)



A rendszer olyan szűrőt alkalmaz, amely vízjelet helyez el a képen.Emboss… (Vízjel...)

Szürkeskálás képet színez meg, amelyet így könnyebben lehet értelmezni.Pseudo Color... (Pszeudo 
szín...)

Az adott kép 3D-s másolatát készíti el.Surface Plot... (Felületi 
kiterjedés...)

A kép egy meghatározott vonalának pixelsűrűségét jeleníti meg 2D-s grafikon formájában.Line Profile... 
(Vonalprofil...)

 Olyan szűrőt alkalmaz, amely lágyít a képen, így csökkenti annak élességét.Diffuse... (Diffúz...)

 Olyan szűrőt alkalmaz, amely szemcsésíti a képet, így csökkenti annak élességét.Granulate... (Szemcse...)

 Új képet hoz létre több, már megnyitott kép kombinációjából.Mosaic... (Mozaik...)

 A videofelvétel készítéséhez hasonlóan ez a művelet lehetővé teszi, hogy több eltérő 
fókuszú képet egyetlen éles képpé olvasszon egybe.

Fusion... (Fúzió...)

 Hamis színösszetételű képeket hoz létre szürkeskálás képekből.Color Composite... 
(Színösszetétel...)

A szerkesztés során további eszközöket vehet igénybe. Ezen eszközökhöz úgy juthat hozzá, ha telepíti őket a Plugin (Beépülő 
modul) menübe.

Az alkalmazás személyre szabásához használja az Options (Opciók) menüt. A használati útmutatóhoz nyomja meg az 
F1 billentyűt vagy kattintson a Help (Súgó) menüre.

 Beépülő  

Beállításo


